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OverviewOverview

The following tutorial provides an introduction to the Mini 
R8C SKP. It explains the basic development environment; 
how to develop and debug programs using HEW (High 
Performance Embedded Workshop) and KD30, and how to 
work with existing example projects.

To get the most out of the Starter Kit, check out the 
references at the end of this tutorial.

Note: This tutorial assumes the user has done the following:
1. Followed the ‘Quick Start Guide’ 
2. Installed the SKP files, examples, and software tools in the default directories.
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The Development ProcessThe Development Process
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SKP8CMINI ConnectivitySKP8CMINI Connectivity
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Mini R8C BoardMini R8C Board
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Mini R8C Board FeaturesMini R8C Board Features
R8C/11 (R5F21114FP) MCU

• 20MHz Operating Frequency at 3.0V – 5.5V, 10MHz Operating 
Frequency at 2.7V – 5V

• 16kB Flash ROM, 1kB RAM
• 24 GPIO including –
• 4 Key-on Wakeup Inputs
• 3 8-bit and 1 16-bit Timers plus a Watchdog Timer
• 12-channel 10-bit ADC
• 2 SIO – 1 Clock Sync + UART, 1 UART
• Voltage Detect and Oscillation Stop Detection 
• Clock sources: Main (Xin), Ring oscillator (Low and High speed)

Onboard Features
• 3 LEDs (Red, Yellow, Green) 
• 2 Switches – 1 slider, 1 pushbutton
• 2 Sensors - Thermistor and CdS cell on two A/D inputs
• Jumpers for Icc measurements and Clock Stop Detect
• I/O available on expansion port headers
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ICD (RTAICD (RTA--FoUSBFoUSB--MON)MON)
The ICD (In-Circuit Debugger) provides power and a USB interface to the 

Host PC and communicates commands and data to and from the Mini 
R8C board via a synchronous serial interface. 

As a debugging tool (during program debug), the ICD + KD30 downloads a 
small kernel (or ROM Monitor) program with the user program to the Mini 
R8C board . This kernel provides a communication interface between the 
R8C/11 MCU and the ICD + KD30 Debugger application on MCU status. 
While the kernel uses some resources of the R8C/11, the operation of 
the ICD is transparent to the user’s program.

As a programming tool, the ICD + Flash-over-USBTM(FoUSB) Programmer 
can be used to download user programs to the R8C/11 MCU on the Mini 
R8C board and many other Renesas’ flash MCU’s (the ICD will support 
other Renesas flash MCU’s by downloading an MCU Monitor Image 
(MMI) file for a particular MCU thru KD30 or FoUSB Programmer).

NOTE: The kernel is only downloaded with the user program when using KD30 
Debugger but NOT the FoUSB Programmer.
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Development ToolsDevelopment Tools
HEW

An Integrated Development Environment (IDE) that invokes all 
necessary software for building your project

KD30
PC software that communicates with the ROM Monitor Program (in flash 

on the MCU) for program debug

NC30 R8C/Tiny Version
C-compiler (limited version of NC30). Conforms to ANSI C standards

(see release notes on limitations) 

AS30
Relocatable Assembler
Supports structured language and a wide variety of macro instructions

Flash-over-USB���� Programmer
Flash programmer for Renesas Flash MCU’s.
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HEW OverviewHEW Overview

HEW is an acronym for High-performance Embedded Workshop.

When writing a microcontroller (or any computer) program, the 
program is usually split into multiple files to make it easier to read and 
understand.

While exactly how the files are organized is up to the programmer, 
typically, the code is split up in a logical manner into various files (e.g. 
math functions in one file, serial port drivers in another, etc). 

After all the files in a project are compiled and assembled, a linker 
combines all the files into a single file. These steps can be tedious and 
repetitive. To make the process simple, we use an Integrated
Development Environment (IDE) called HEW.
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Start HEWStart HEW

From the Windows Start menu, click on
Programs > Renesas High-performance Embedded Workshop>

High-performance Embedded Workshop
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Open a HEW Workspace (1/3)Open a HEW Workspace (1/3)

1. After HEW opens, from the Welcome dialog box, select
‘Browse to another project workspace’ option, then click OK.

2. Click ‘OK’ button



12

Open a HEW Workspace (2/3)Open a HEW Workspace (2/3)
Using the Open Workspace dialog box, browse until you get to 
‘C:\MTOOL\SKP8CMINI\Sample_Code\Tutor1’ folder. Click on
Tutor1.hws HEW workspace file and then click on ‘Open’ button.
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Open a HEW Workspace (3/3)Open a HEW Workspace (3/3)
HEW should look like the figure below.

Output window

Editor windowWorkspace window

Toolbars

Menu bar



14

Workspace WindowWorkspace Window

Try the following, click on ‘Show 
dependencies under each file’ and see 
what happens to files displayed on the 
window.

To open a source file, 
double-click on it.

In the Projects tab, source files and header 
files are displayed.

To change how dependencies are displayed, 
e.g. show dependencies for each source 
file, right-click within the window, and 
select Configure View.
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Editor (Source) WindowEditor (Source) Window

Any opened source file within the workspace are 
shown on the Editor window.

Line, total no. of lines, 
and column numbers 
are displayed here
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HEW ToolbarsHEW Toolbars

Editor Toolbar2 Debug Toolbar1

Bookmarks Toolbar2

Standard Toolbar

Templates Toolbar2

Debug Run Toolbar1

Search Toolbar2

Version Control
Toolbar2

HEW is a powerful development environment with a lot of features
and functionality. For this tutorial, the focus will be on features (i.e. 
Standard Toolbar) that will help you understand the R8C development 
process using HEW. 

Notes: 
1. On HEW 3.0 R1, R8C is not supported by the Debug and Debug Run toolbars.
2. See HEW user’s manual about these toolbars.
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Standard ToolbarStandard Toolbar
Build File

Current Debugger Session1

Current Configuration1

View Workspace1

Launch Debugger

View
Output1

Build

Build All

Stop

Launch 
Slave HEW2

Build File – builds3 a specific file
Build – builds files that were modified since last build
Build All – builds the whole project regardless of whether there were 

modifications or not
Stop – stops a running build process
Current Configuration – build configuration (e.g. for debug, optimized, etc)
Current Debugger Session – debug session configuration 
Launch Debugger – calls defined debugger 

Notes:
1. These features are not currently supported for R8C development.
2. See HEW User’s manual for details.
3. A ‘build’ means running certain files (e.g. source files) under some tools (e.g. compiler,  

linker) to produce an output file (e.g  X30 or MOT executable files for R8C)
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Build(reBuild(re--build) Tutor1build) Tutor1

Let’s rebuild the Tutor1 project into an executable module, click on the 
‘Build All’ icon. This will re-compile and link all the source files. 

If any of the source files are modified, click on the ‘Build’ icon as this 
will only compile these modified files, which makes generating an 
executable module faster.  

Always perform a ‘Build All’ when the configuration changed.

Status, errors, messages, etc during a build process is displayed on 
the Output window...

Build All
(re-build) 

Build 
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Output WindowOutput Window
The major use of the Output window is to determine if any errors or warnings 
occurred, and where, during the build process.

The no. of errors and warnings will show up in this window.  You can then 
scroll up to find where the error(s) occurred. If no errors or warnings were 
found, ‘Build Finished’ will be displayed.

Now that an executable file has been created, the next step is to download and 
run the program on the Mini R8C board using the KD30 Debugger + ICD…

Do not close HEW yet. We will be returning to it later. 
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KD30 Debugger OverviewKD30 Debugger Overview
The KD30 Debugger can be used to verify that the program we 
developed works exactly as we intended and when it does not, we 
can also use KD30 to find out why.

Two breakpoints can be set in KD30 to stop the program at 
certain points (of our program) so we can verify that up to that
point, the program still works correctly using registers or variables 
in memory.  

KD30 allows “step” execution in our program, which means 
program execution on a per line basis (whether in source level or 
machine code level).

Various windows in KD30 allow us to see register values and 
memory locations.
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KD30 Debugger ExerciseKD30 Debugger Exercise

• Download and run a program on the Mini R8C board
• General use of the KD30 Debugger including 

stepping and setting breakpoints
• Return to HEW, modify the program, rebuild, and run 

the updated program on the Mini R8C board
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Connect HardwareConnect Hardware
Before starting KD30, connect the ICD to the Mini R8C board as shown. 
Connect the USB cable to the PC. On the ICD, the Power LED is on and the 
Status (Yellow) LED is blinking once a second (this means that the ICD USB 
driver was loaded correctly by WindowsTM).

To 
PC

USB 
cable

ICD (In-Circuit Debugger) Mini R8C board

Note: The Mini R8C board connector is not keyed, so pay close 
attention when connecting to the ICD.
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Start KD30Start KD30

Launch KD30 from the Windows Start Menu,

or from HEW’s Standard Toolbar1.

Note: 1. To call KD30 from HEW requires some configuration that is  
discussed in tutorial 2, Creating a New Project.
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KD30 Init Window (1/2)KD30 Init Window (1/2)

Step 2. Select USB

Step 3. Now click the 
‘Run Mode’ tab

Step 1.  Click on ‘Refer..’ and 
select ‘R5F21114FP.MCU’.
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KD30 Init Window (2/2)KD30 Init Window (2/2)

For full debugging 
features, be sure 
‘Sampling Mode1’
is selected.

‘Free Run Mode1’ is 
for real time 
execution of your 
program, but 
debugging is limited. 
Do NOT select for 
this tutorial.

Now click ‘OK’ to open KD30’s Program window (be sure hardware is 
connected). If you get an error, check all connections. See SKP user’s 
manual  on ‘Troubleshooting’ for details.

Note 1. See KD30 User’s Manual or Help for the differences between Sampling 
Mode and Free Run Mode. Also, see the ICD (RTA-FoUSB-MON) User’s Manual 
for details on how ICD works under these two modes. 
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KD30 Program WindowKD30 Program Window

KD30 will disassemble the flash contents or display ‘UND’
if  the flash is blank.
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KD30 ToolbarKD30 Toolbar

Go Button
Executes target 
program

Step Button
One step execution
of target program

Return Button
Runs the program up to
the higher routine

Break Button
Sets a software breakpoint at the current 
cursor position

S/W Button
Sets a software breakpoint

Come Button
Executes the target program
from the value in the
program counter to the
position of the cursor in 
the window

Over Button
Step over function/subroutine call

Stop Button
Stops execution of the 
target program

Reset Button
Resets the target program
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Download a Program to the Download a Program to the 
Mini R8C Board (R8C/11 MCU) (1/3)Mini R8C Board (R8C/11 MCU) (1/3)

Click on ‘File’, then select ‘Download’, ‘Load Module’…
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From the c:\MTOOL\SKP8CMINI\Sample_Code \Tutor1\
Tutor1\release folder, select ‘Tutor1.x30’.

Download a Program to the Download a Program to the 
Mini R8C Board (R8C/11 MCU) (2/3)Mini R8C Board (R8C/11 MCU) (2/3)
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Current 
location of 
MCU program 
counter is 
highlighted.

Now click on “View” to see the program source code…

After downloading the program, KD30 opens the source file where the 
reset vector is.

Download a Program to the Download a Program to the 
Mini R8C Board (R8C/11 MCU) (3/3)Mini R8C Board (R8C/11 MCU) (3/3)
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Viewing Source Files in the ProjectViewing Source Files in the Project

4. Double-click ‘main’
to view it on the 
Program Window

3. Click 
‘TUTOR1.r30’

2. Source window 
is displayed.

1. Click 
‘Source’
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Running Downloaded ProgramRunning Downloaded Program
Click on the ‘Go’ icon to run the Tutor1 program you just downloaded. 
LED’s D1, D2, & D3 will blink sequentially. Covering the CdS light cell 
will decrease the LED blink rate and uncovering it will increase it.

Click ‘Mix’ to 
view the source 
code and 
assembler code.
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Stopping Program ExecutionStopping Program Execution

Click on the ‘Stop’ icon 
to stop the program
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Setting BreakpointsSetting Breakpoints

2. Locate and then set a breakpoint on ‘else’ in main() by a double-click on 
‘-’ in the ‘BRK’ column that denotes an executable line. A ‘B’ will appear in 
its place after the breakpoint is set and the line(s) is highlighted in red.

1. Click on the ‘Source’ to view source code only (not MIX display).

3. Click on ‘Go’ icon to run program…
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Removing BreakpointsRemoving Breakpoints

Program stops
at breakpoint 
(highlighted in 
Yellow).You can remove the breakpoint by double-

clicking on it at the ‘BRK’ column.
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Program Program ‘‘SteppingStepping’’

Try ‘stepping’ a few lines of code by clicking on ‘Step’ icon. Click 
on ‘Go’ afterwards to run program again.
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Basic Windows: RegisterBasic Windows: Register
Now open the ‘Register’ window

Note: Resize the Register window as needed.

The Register window displays the values of the CPU registers after 
executing an instruction. 

Values in red 
indicate 
changes since 
last “viewed”. 
Try ‘stepping’
and note the 
changes.
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Basic Windows: RAM MonitorBasic Windows: RAM Monitor
Open a RAM Monitor window (Basic Windows > RAM Monitor Window). 
The RAM Monitor displays the current value of the memory area shown on 
the window. It is updated at a preset value which can be modified by the 
user. 

Double-click an address and enter 400 (hex). KD30 will tell you the page is 
going to change, click ‘OK’ (adjust the window size as needed). 

Click the ‘GO’ icon. Note you can view the RAM as it is updating. 
This function is not available in “Free Run” mode. Click the ‘STOP’
icon before proceeding.
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Basic Windows: Memory & C WatchBasic Windows: Memory & C Watch

The ‘Memory Window’ displays the
location and contents of variables

Double-click on the variable to 
change display format: i.e., change 
‘char’ to ‘hex’ to ‘decimal’, etc.

Open a C Watch window (Basic 
Windows > C Watch Window). The ‘C 
Watch Window’ allows you to view 
globals and locals. An example is 
shown below.

Open a Memory window (Basic 
Windows > Memory Window). 
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Modifying the Program (1/2)Modifying the Program (1/2)

If Tutor1.c is not shown on the Editor window, double-click on it in 
the Workspace window and the file will be opened/displayed on the 
Source window. 
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Modifying the Program (2/2)Modifying the Program (2/2)

1. Scroll down and find the 
function ‘tmrZ_isr’ routine.

3. Click this to save the revised file.

2. Change this line to
‘tzpr = (0xFF – adl);’.

4. Build the project again.
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Load (reLoad (re--load) Modified Programload) Modified Program
In KD30, with the program stopped, reload code by selecting ‘Reload’ from 
the File menu.

Covering the Light sensor on Mini R8C board increases the 
LED blink rate. Uncovering it decreases the blink rate.
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End of TutorialEnd of Tutorial

This is the end of the tutorial. You can try downloading 
other sample programs from the \Sample_Code 
directory.

Tutorial 2 provides step by step instructions on how to 
use the Project Generator to simplify project creation.
It also provides specific details on setting up your 
environment and creating a new project from scratch. 

In addition, check out the references on the next page.

Have Fun!!
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References and Recommended ReadingReferences and Recommended Reading
All documents that came with the SKP can be found using the “Document 
Description” from the Start > Programs > Renesas-Tools > SKP8CMINI 
menu.

• SKP8CMINI User’s Manual: This is a “must read” document! It details all the 
things you need to know on how to use the Starter Kit.

• R8C/11 Datasheet and Mini R8C Board Schematic: These are required to 
write user application programs.

• HEW User’s Manual: To fully understand and get the most out of HEW, this 
is recommended reading.

• KD30 Version X.XX Help: The tutorial only covered the basics of KD30. 
Check out the Help menu to find out all of KD30’s features.

• NC30 Version X.XX User’s Manual: Check this manual out for features 
specific to the NC30 compiler. 

• RTA-FoUSB-MON User’s Manual: Read this manual to understand how the 
ICD works.
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More References and Recommended ReadingMore References and Recommended Reading

• M16C/10/20/60 Series C Language Programming Manual: This is a great 
document for any level of programmer. The first chapter is an intro to C 
programming. The next chapter explains the memory map of C programs on 
microcontrollers and the role of startup programs. 

• R8CTiny Series Software Manual: This document describes the instruction 
set and timing information for the R8C/Tiny series MCUs. 

• AS30 Version X.XX User’s Manual: Read this manual if you plan on writing 
programs in Assembly or when making changes to the startup file.

• Application Notes and Sample Programs: Application notes and other 
sample programs can be accessed from Renesas Technology America’s 
website: http://www.renesas.com.


